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Introduction 
 
This document provides guidance, steps and procedures for creating 1:50,000 scale 
Topographic Line Maps (TLM50s) with the MPS 3.1 software solution.  The steps can, 
and should be, used as reference for any map sheets generated with MPS 3.1.  
 
The first section covers System Setup.  This section covers items that should be 
addressed prior to producing any TLMs with MPS.  The required fonts are covered, as 
well as, information as to how to acquire those fonts.  The PMC and its many 
relationships to MPS are also discussed in this section.  This includes how to add missing 
map sheets indexes to the lists of available map sheets on the Create Map Sheet Menu. 
 
The MPS Margin and Surround Elements section is devoted to creating and editing the 
various surround elements used in TLM production.  Specific step-by-step instructions 
concerning the surround elements are not provided in this document, as this can be found 
in the PLTS Help available in ArcMap.  Rather reference information concerning the 
format and content of the elements is provided based upon current specifications. The 
Elevation Guide is one exception as there are instructions and guidelines that should be 
followed to successfully produce the Elevation Guide Box.   
 
Grid systems are addressed in the next section.  Steps for creating TLM50 grid systems, 
including Decimal Degree systems and MGRS are outlined.  This includes steps for 
creating secondary grid systems for those map sheets that fall near a UTM zone split.  
Steps and important tips for converting these grids to feature classes or graphics are also 
discussed.    
 
Output of TLM map sheets is covered in the next section.  This includes output processes 
used in TLM production for generating hard copy plots, color separates, and E-Chart 
production.   
 
The final section is devoted to Troubleshooting and FAQs.  
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System Setup 
Fonts 
 
You must have the entire Zurich family of fonts installed on your system in order to 
generate any of the Defense Solution Map Series (i.e. TLM100, TLM50, JOG, etc.).  The 
fonts can be purchased through BitStream, Inc.  For more information on purchasing 
these fonts refer to www.bitstream.com.   

PMC and MPS 
 
The Project and Mapsheet Catalog (PMC) is an integral part of the Map Production 
System.  The PMC contains many important pieces of information, including: 
 

 All of the available Areas of Interest (AOI) for each map series   
 All of the properties for the MPS Surround Elements 
 All of the Placement Rule information 
 Feature datasets and feature classes for the Boundary Guide, Adjoining Sheet 

Guide, and Elevation Guide  
 Index of map sheets used in the generation of the Adjoining Sheet Guide 

 
The PMC stores all of the available Areas of Interest (AOI) for each map series used 
during map production.  Within the PMC geodatabase, there is a PMC feature dataset.  
This feature dataset contains polygon feature classes that represent the AOIs for each 
map sheet in a map series.  Each of these feature classes has the same name as the map 
series they are associated with.  When a user chooses a Map Series in the Create Map 
Sheet menu, all of the AOIs in the associated feature class are listed in the scrolling list of 
Mapsheets in this menu.  For example, if a user selects the TLM50 Map Series, MPS then 
returns all of the features in the TLM50 feature class in the PMC feature dataset within 
the PMC geodatabase.  It then lists the value in the MSNAME attribute in the scrolling 
list of Mapsheets.  If you are creating a new map series, use the PMC Source Builder 
available in ArcMap to generate the required polygon feature classes within the PMC 
(See the PMC Chapter in the PLTS Help). 
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When an individual map sheet is selected from the list of available AOIs, either through 
clicking on mapsheet name, or visually selecting the mapsheet, the associated polygon 
feature is used to define the location and extent of the basemap.  
 
In addition to the map sheet AOIs, the PMC also stores the information required to 
generate each map sheet in a series of database tables. This information includes all of the 
properties for each element on the map sheet and all placement rule settings.  When you 
click on ‘Save’ in the Create Map Sheet menu, MPS saves all of the elements and the 
placement rule settings into these tables.  Any surround element that has a data frame as 
one of its components (Adjoining Sheet Guide, Boundary Guide, and Elevation Guide) is 
also stored in a feature dataset and a series of feature classes.  The feature datasets and 
feature classes are created by MPS when one of these elements is generated for the first 
time.  The name of the feature dataset corresponds to the name of the element. These 
feature classes can then be opened and edited (generalizing the Elevation bands) in 
ArcMap.  

 
 
 
 
 
 
 
 
 
 
 
 

Elevation Guide 

Boundary Guide 

Adjoining Sheet Guide 

 
The last piece of information being held within the PMC is used only for the Adjoining 
Sheet Guide.  Within the PMC there is a Reference Data feature dataset.  This feature 
dataset holds a feature class called TLM50_Index.  This feature class stores the index that 
is used to generate the information present in the Adjoining Sheet Guide element.  If the 
Adjoining Sheet Guide is missing information, or not generating, this is the feature class 
that needs to be updated.   
 
The PMC is an integral part of the MPS workflow.  The PMC holds the information that 
defines the extent and location of the basemap in the PMC feature dataset. The feature 
classes in the PMC feature dataset can be updated with new sheets, updated extents, or 
sheet names.  All of the placement rules and element properties are stored in unique 
tables within the PMC.  In addition, the PMC holds all of the necessary feature classes for 
the generation of the Adjoining Sheet Guide, Boundary Guide, and Elevation Guide in 
separate feature datasets.  The Adjoining Sheet guide also uses feature classes within the 
Reference Data feature dataset to generate the surrounding map sheet information.   
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Updating Available Map Sheets 
 
A PMC geodatabase is included on the PLTS installation CDs to use within MPS.  
Within this PMC the TLM50, TLM100 feature classes have been provided as complete as 
allowed by NGA.  There are some areas that are not populated, and for some areas the 
map sheet extents may need to be updated.  Either of these tasks can be easily 
accomplished using either ArcCatalog or ArcMap.   
 
Adding Map Sheets to the PMC 
 
Map Sheets that are not available in the scrolling list provided in the Create Map Sheet 
menu can be imported a number of ways.   If a single sheet needs to be added, the AOI 
button located on the Create Map Sheet menu can be used to generate the new map sheet.  
The extent of this map sheet can be entered manually through the interface, or imported 
from another format.  See the PLTS Help, Map Production System>Map Sheets>Area of 
Interest(AOI) chapter for more information about this topic.   
 
If multiple map sheets need to be added and these extents are present in another location 
and format (shapefile, coverage, feature class, etc.) the Simple Data Loader in 
ArcCatalog can be used to import the missing sheet boundaries directly into the feature 
class associated with the map series.  As discussed earlier, this feature class can be found 
in the PMC feature dataset, and has the identical name as the map series.  The MPS 
software uses the MSNAME attribute on this feature class as the unique identifier for 
storing and retrieving information about a map sheet.  For that reason it is very important 
that this attribute is populated with an appropriate value.  This can be accomplished 
during the loading process or after the load process in an ArcMap edit session.  For more 
information on using the Simple Data Loader see the ArcGIS Help.   
 
Updating Existing Map Sheets  
 
In some cases the boundaries of existing map sheets may need to be updated.  Again, the 
map sheet boundaries are stored as features in a feature class. If the map sheet boundaries 
need to be updated, simply open the appropriate feature class (with the same name as the 
map series) in an ArcMap session and edit the boundaries.  

Adjoining Sheet Guide Information 
 
If new map sheets are added or existing ones updated, it may be necessary to update the 
information used by the Adjoining Sheet Guide element.  This information is stored as a 
feature class in the Reference Data feature dataset located within the PMC geodatabase.  
For the TLM products there are a TLM50_Index and a TLM100_Index feature.  If new 
map sheets are added to the PMC feature dataset, verify that those map sheet extents also 
exist in this feature class/dataset as well.   
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In addition to the geometry of the map sheet, attribute information will also need to be 
populated in order for the Adjoining Sheet Guide to generate properly.  The fields that 
must be populated are as follows: 

 SERIES – This should be populated with the series that the map sheet belongs, 
i.e. A742 

 ITEM – This should be populated with the map sheet number, i.e. 64462 
o For TLM50s the mapsheet number will end in 1, 2, 3, or 4.  When the 

element is generated those numbers will be converted to roman numerals. 
 NRN – This should be populated with the NGA Reference Number associated 

with the map sheet.  Generally this is the SERIES concatenated with ITEM with 
‘X’ between the two numbers i.e., A742X64462. 

 GEOP – This should be populated with the country code that the map sheet lies. 
 

MPS: Margin and Surround Element Editing 
 
The Map Production System has been designed to generate all of the required surround 
elements needed to meet the TLM50 Specifications.  Once the elements are created, the 
Placement Rules will be used to position all of the surround elements in the proper 
location on the page layout.  While the Placement Rules are a great help in storing and 
placing the elements in the proper location on the page, they require a lot of overhead if 
elements need to be edited beyond what is available on an element’s property page. It is 
for this reason that once all of the elements are generated and placed on the page, it is 
suggested that the map sheet be saved as an MXD.  Once the map sheet is saved as a 
MXD, elements on the map sheet can be easily ungrouped for editing and re-grouped.  
 
 ************** 

After the transition to a MXD, the map sheet will no longer be edited through the 
MPS software and the Create Map Sheet Menu. 

 
************** 

 
Once the map sheet has been transitioned into an MXD the surround elements on the map 
sheet can be edited very easily. The MPS software generates two main types of surround 
elements on a map sheet.  These two types are grouped graphic elements and grouped 
graphic elements with a data frame.  The majority of the surround elements fall into the 
first category.  These elements can be ungrouped and each graphic component (text, line 
and poly symbols) can be changed, edited, or updated.  There are only three elements that 
fall into the second category: the Adjoining Sheet Guide, the Boundary Guide, and the 
Elevation Guide. These elements can also be ungrouped, and the graphic elements edited.  
In addition, the information in the data frame can be edited in a separate ArcMap session 
if required.  Steps for completing these types of edits are outlined in the sections that 
follow.  
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TLM Surround Elements - Generation 
 
The TLM Specific elements listed below will be generated using the MPS software.  All 
of the elements should be generated as completely as possible prior to saving the map 
sheet as an MXD.  The elements are set up so that the default values will match the 
specifications described below.  Refer to the PLTS Help for more information on 
generating each element.  The steps required for successfully generating an Elevation 
Guide element are outlined in detail below.   

Adjoining Sheets  
Add additional annotation for Country names if there are international borders in the 
adjoining sheets box.  International boundaries and areas not within the series should be 
symbolized in accordance with the Style Guide.  Also refer to Specification MIL-T-
89301A, 3.11.10. 

 Refer to the ReferenceData Feature Dataset for default values. 
 TLM50 standard font is used 
 Title - 9pt Zurich Bold Condensed CAPS MPSBlack  
 Text/Sheet numbers – 6pt Zurich Condensed CAPS MPSBlack 
 Bottom text – 5pt Zurich Light Condensed U/L MPSBlack 
 Right text – 4pt Zurich Light Condensed U/L MPSBlack 

Boundary Guide  
Add boundary administrative name (and arrows if necessary) to customize Boundaries 
guide.  Refer to Style Guide and Specification MIL-T-89301A, 3.11.19 and 3.11.20. 

 Title - 9pt Bold Condensed CAPS MPSBlack 
 Country Name - 6pt Condensed CAPS MPSBlack 
 First Order Administrative Boundaries - 5pt Condensed CAPS MPSBlack 
 Second Order Administrative Boundaries – 5pt Condensed U/L MPSBlack 
 Disclaimer - 6pt Light Condensed U/L MPSBlack 

Contour Interval Note  
Refer to Style Guide and Specification MIL-T-89301A, 3.11.15 for content.  Only 
include supplementary text if supplementary contours exist. 

 Contour Interval - 9pt Bold Condensed CAPS MPSBlack 
 Supplementary Contours - 6pt Bold Condensed CAPS MPSBlack 

Conversion Graph 
No customization should be necessary.  Verify that the graph was generated properly.  
Refer to Style Guide and Specification MIL-T-89301A, 3.11.23. 

Coordinate Conversion Note  
Refer to Style Guide and Specification MIL-T-89301A, 3.11.31 and Coordinate 
Conversion document in NGA source.   

 First line - 6pt Condensed CAPS MPSBlack 
 Following lines - 6pt Condensed U/L MPSBlack 
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Copyright Note 
Refer to Style Guide, Specification MIL-T-89301A, 3.11.32 and General Notes document 
in NGA source for content. 

 Title (main text) - 7pt Condensed CAPS MPSBlack 
 Supplemental text - 5pt Condensed CAPS MPSBlack 

Country Name Note 
Country Name appears twice on the mapsheet – Top left corner with additional scale 
(1:50,000) text following and bottom left.  Refer to Style Guide, Specification MIL-T-
89301A 3.11.4 and Geographic Name Guidance document in NGA source for content. 

 Name - 16pt Bold Condensed CAPS MPSBlack 

Datum Note 
Datum appears twice on the mapsheet – Top left corner and bottom right corner under 
Red-light Readable note.  Refer to Geodetic Report document in NGA source for content. 

 Text - 20pt Bold Condensed CAPS MPSRedBrown 

Edition Note 
Edition appears twice on the mapsheet – Top right corner with supplemental text and 
bottom left corner.  Refer to Style Guide, Specification MIL-T-89301A, 3.11.6 and 
Series, Sheet, Edition document in NGA source for content. 

 Text - 16pt Bold Condensed CAPS MPSBlack 
 Supplementary text (top) – 9pt Condensed CAPS MPSBlack 

Elevation Guide  
Follow the procedures below for generating the Elevation Guide Box.  You will need to 
edit elevation zones, add drains, add spot heights, and add spot height values (discussed 
in the TLM Surround Elements – Editing).  Also, refer to MIL-STD-89301A, section 
3.11.18 for additional guidance.   
 
Prior to generating the elevation guide 

 Go to Tools > Options… in the ArcMap main menu.  In the window that appears 
select the Application Tab and uncheck the option for New Layer Visibility – 
Make newly added layers visible by default.  Close the Options window. 

 Add the DTED for your map sheet as a layer.   
 

**** Do NOT Turn the DTED Layer On ****  
 A visible DTED layer will stop you from generating the EGB because of the 

map sheet’s projection properties.  If the DTED is turned on you will not see it in 
the map sheet!  If the DTED is turned on you must remove the DTED Layer 

from the map sheet, re-add the DTED and re-generate the Elevation Guide Box. 
 

Generating the Elevation Guide Element 
 Select MPS Elements > TLM > Elevation Guide Box 
 Select the Elevation Classes Tab on the Elevation Guide Box Property Page 
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 For DTED Source Layer: Confirm correct DTED is listed. 
 Output Path Name: Confirm that is pointing to the PMC for the map-sheet. 
 Elevation Bands/Class Breaks: Confirm that this set to the correct contour interval 

for the map sheet. 
 Click on the Calculate button to calculate the elevation band ranges.  This may 

take a few seconds. 
 Select the Hydrographic Inclusions Tab.  
 Turn ALL check marks OFF for hydrographic lines and areas.  You will import 

the necessary streams once the elevations bands are generated. 
 Select the GeoProcessing Tab 
 In the section – ‘Step 2 Minimal Area (Optional)’ enter 250,000 for the Remove 

Areas below option.  Increase this number in order to remove additional small 
polygons. 

 Click on Apply. 
 Save the Map Sheet by Selecting Save on the Create Map Sheet menu. 
 Once the save is complete, use the placement rules to position the Elevation 

Guide Box in the proper location.   
 Once the element is in the correct location, again save the Map Sheet through the 

Create Map Sheet Menu. 

Glossary 
This element is generated while in MPS using the general Glossary terms from 
Geographic Names Guidance in NGA source (Generic Name and Feature Designation 
Name).  Customize Glossary terms (delete or adding terms that are sheet specific) and 
add diacritics where necessary once the map sheet has been converted to an MXD.  Refer 
to Style Guide and Specification MIL-T-89301A, 3.11.12.  

 Title - 9pt Bold Condensed CAPS MPSBlack 
 Term text – 6pt Light Condensed U/L MPSBlack 

Legend 

Customize Legend to contain sheet specific symbols and text where necessary – Area 
Name, Spot Elevation high and low.  Refer to Style Guide and Specification MIL-T-
89301A, 3.11.11. 

 Title - 9pt Bold Condensed CAPS MPSBlack  
 Feature text – 6pt Condensed CAPS MPSBlack 
 Additional text – 6pt Light Condensed U/L MPSBlack (what is this “Additional” 

text) 
 

Limited Distribution Note  
Limited Distribution note appears beneath Slope Guide or North Arrow.  Refer to Style 
Guide, Specification MIL-T-89301A, 3.11.30 and General Notes document in NGA 
source for content. 

 Title - 14pt Bold Condensed CAPS MPSRedBrown 
 Note text– 6pt Condensed U/L MPSRedBrown 
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Map Information Note (Currency notes) 
Map Information note appears in the bottom left corner following Logo.  Refer to Style 
Guide, Specification MIL-T-89301A, 3.11.21 and Map Info Date document in NGA 
source for content – this should contain the latest source date.   

 Text - 7pt Condensed CAPS MPSBlack 

Map Sheet Notes 
Note appears in the bottom left corner beside Legend.  Refer to Style Guide, 
Specification MIL-T-89301A, 3.11.22 and Notes document in NGA source for content.   

 Title - 9pt Bold Condensed CAPS MPSBlack 
 Text – 6pt Condensed CAPS MPSBlack 

Map Specification Note 
No customization should be necessary - verify generated properly.  Refer to Style Guide, 
Specification MIL-T-89301A, 3.11.16 and MIL-T-89301A, 3.11.17 and MIL-T-89301A, 
3.11.27 and Geodetic Report in NGA source when creating in PMC. 

 Text - 6pt Condensed CAPS MPSBlack 

Meter Reference Guide 
No customization should be necessary - verify that the guide generated properly.  Refer 
to Style Guide, Specification MIL-T-89301A, 3.11.23 and Tab Run (100,000 Meter Grid 
Square Identification) in NGA source when creating in PMC. 

North Arrow 
No customization should be necessary - verify generated properly.  Refer to Style Guide 
and Tab Run (Declination Data) in NGA source when creating in PMC.  

 Text - 6pt Condensed CAPS MPSBlack 

Prepared and Published Note 
Prepared and Published note appears in the bottom left corner following Logo.  Refer to 
Style Guide and Specification MIL-T-89301A, 3.11.26. 

 Text - 8pt Condensed U/L MPSBlack 

Red-light Readable Note 
Red-light Readable note appears in the bottom right corner.  Refer to Style Guide and 
Specification MIL-T-89301A, 3.11.25 for content. 

 Text - 8pt Bold Condensed CAPS MPSRedBrown 

Road Destinations text and arrow 
Road destinations are not generated by MPS, but are considered surround elements. The 
road destination elements consist of a destination arrow and text describing the next 
population center and the distance in 1/10 km increments for those under 10 kilometers 
and whole numbers for those destinations greater than 10 kilometers away along the 
transportation feature.   These elements are delineated where necessary along the outside 
edge of a map sheet.  Arrows should follow the same orientation of the transportation 
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feature – rotate accordingly.  Refer to Style Guide and Specification MIL-T-89301A, 
3.12.9.  The text components should follow these spacing requirements: 

 1mm from grid values 
 6mm from the grid (8mm on the south edge)   

The symbols used for the road destination arrows are as follows: 
 Text - 5pt Condensed  MPSBlack  e.g. REDLANDS 5km. 
 Destination Arrow is a Point Graphic symbol ‘Destination Arrow (arrowhead)’ 

and ‘Destination Arrow (arrowhead an tail)’ available in the TLM50, and 
TLM50_highres styles. 

Scale Bar 
No customization should be necessary - verify generated properly.  Refer to Style Guide 
and Tab Run (Declination Data) in NGA source when reviewing. 

Seconds of Lat/Long Notes 
Seconds of lat/long notes appear four times – center north, south, east, and west portions 
on the mapsheet.  Refer to Style Guide and Tab Run in NGA source for content. 

 Title - 6pt Light Condensed Italic U/L MPSBlue 

Series Note 
Series appears twice on the mapsheet – Top right corner with sup text and bottom left 
corner.  Refer to Style Guide, Specification MIL-T-89301A, 3.11.5 and Geodetic Report 
or Series, Sheet, Edition document in NGA source for content. 

 Text - 16pt Bold Condensed CAPS MPSBlack 
 Supplementary text (top) – 9pt Condensed CAPS MPSBlack 

Sheet Name Note 
Sheet Name appears twice on the mapsheet – Top Center (24pt) and bottom left (16pt).  
Refer to Style Guide, Specification MIL-T-89301A, 3.11.7 and Geographic Name 
Guidance document in NGA source for content. 

 Name (top)- 24pt Bold Condensed CAPS MPSBlack 
 Name (bottom) - 16pt Bold Condensed CAPS MPSBlack 

Sheet Number Note 
Sheet Number appears twice on the mapsheet – Top right corner with sup text and bottom 
left corner.  Refer to Style Guide, Specification MIL-T-89301A, 3.11.8 and Series, Sheet, 
Edition document in NGA source for content. 

 Text - 16pt Bold Condensed CAPS MPSBlack 
 Supplementary text (top) – 9pt Condensed CAPS MPSBlack 

Slope Guide Element 
The Slope Guide element appears in the lower right corner of the map sheet.  The actual 
placement of this element can vary based upon the available space.  The scale and 
contour interval for the map sheet are the only parameters need to generate the slope 
guide element.  Refer to Style Guide and Specification MIL-T-89301A, 3.11.8 for 
content. 
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Unit of Elevation Note 
Unit of Elevation note appears in the bottom center.  Refer to Style Guide and 
Specification MIL-T-89301A, 3.11.14 for content. 

 Text - 10pt Condensed CAPS MPSRedBrown 

Users Note 
Users note appears in the bottom center.  Refer to Style Guide and Specification MIL-T-
89301A, 3.11.29 and General Notes in NGA source for content. 

 Text - 6pt Light Condensed CAPS MPSBlack 
 
 
 
 
 
TLM Surround Elements - Editing 
 
Once all of the surround elements have been generated they can be edited beyond what 
the element’s property pages allow.  While these edits can be performed within MPS, 
there are some extra steps that need to be followed.  These extra steps are a direct result 
of one of MPS biggest assets, the Placement Rules.  An alternative to performing the 
edits in MPS is to save the map sheet as an MXD.  By doing so, all of the surround 
elements become simple grouped graphics that can be ungrouped, edited, and re-grouped 
easily.  The drawback is that the element property pages and generation tools are not 
available and any changes made in the MXD are not stored into the PMC.  It is suggested 
that the surround element edits be performed in and MXD rather than in MPS.   
 
Once all of the surround elements are generated, save the map sheet as an MXD.  The 
MXD will be used from this point forward in the production process (all of the following 
steps assume that the map sheet has been saved as an MXD and is referenced as 
‘mapsheet.mxd’ in the steps).   
 
Editing the surround elements will consist of either editing the graphic elements that 
make a particular surround element, or the feature classes that are being displayed in the 
element’s data frame.  Graphic edits can be completed easily using the tools available on 
the ArcMap Draw toolbar.  Individual text, line, polygons, and point graphic elements 
can be created and edited using this toolbar.  All graphic elements have properties that are 
unique to that particular type of element.  Select a graphic element, right-click, and select 
‘Properties’ to access these unique property settings.  Some elements, as mentioned 
earlier, contain a data frame.  Data frames contain layers, which are pointers to feature 
classes.  These feature classes can be edited in a separate ArcMap session and the edits 
will be reflected in your map sheet (either MPS or MXD). 
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General Editing of Surround Elements - MPS 
 
If the map sheet has not been saved as an MXD, all of the edits mentioned here can be 
performed within MPS and the Create Map Sheet Edit Session.   There are a few extra 
steps that must be followed when performing any ungrouping / re-grouping of the 
surround elements as a result of the Placement Rules.  The Placement Rules use a 
surround element’s name as an identifier for each element.  When an element is 
ungrouped, the name is lost.  Any placement rule that was using that element name is 
then lost as well.   
 

 Select the Surround Element that will be ungrouped. 
 Right-click and select Ungroup.  
 Perform the required edits to the graphic elements (Don’t save yet!) 
 Select all of the graphic elements  
 Right-click and select Group 
 Save through the Create Map Sheet Menu 
 Open the Placement Rules Dialog 
 Scroll to the bottom of the elements list and select the ‘Group1’ element 
 Click on ‘Name’ and name the element, then click OK. 
 Click and drag the element’s position to the proper location in the draw order.   
 Set the placement rules for that element. 
 Re-set the placement rules for any other surround element that was using the 

original surround element in its rules to the new element (The element name in 
the Dependent XX box will be <None>). 

 Click OK 
 Save the map sheet through the Create Map Sheet Menu. 

 
Customizing the Elevation Guide 
 
The Elevation guide requires the most editing after being generated by the MPS software.  
All of the edits for the elevation guide can be performed while editing the map sheet in 
MPS or as an MXD – as none of the edits require ungrouping the Elevation Guide 
element.  As discussed above, any surround element that contains a data frame also 
contains feature classes.  These feature classes can be edited in a separate ArcMap 
session.  Once the edits are complete, and the changes saved, a refresh of the map sheet 
will incorporate the changes into the element.   
 
Editing contents of the Elevation Guide Box 
 

 After EGB generation open up a new ArcMap session. 
 Add all Elevation Guide Layers 

o The Layers are located in the PMC geodatabase, under the ElevationGuide 
Feature Dataset 

 Set up Definition Query to edit the Elevation Guide features for your map sheet 
o Select the ElevationGuideA feature layer 
o Right-Click and select Properties 

PLTS TLM50 Guidance Using MPS 3.1 - September 2004  12   



PLTS TLM50 Guidance Using MPS 3.1   September 2004  

o Select the Definition Query Tab 
o Click on the ‘Query Builder…’ button 
o In the Fields list – double click on the ‘MSNAME’ attribute 
o For the operator, select  ‘=’. 
o Either Find the MSNAME in the Unique List on the right of the window 

and double click on it, or enter in the name of the mapsheet surrounded by 
single quotes – i.e., ‘V795X64462’ 

o When the Query is set Click Verify, click OK  
o If the expression passed, Click OK on the Query Window, and OK on the 

Properties window 
o Zoom to the visible features. 

 Create Map Topology for shared editing  
o Select More Editing Tools > Topology 
o Click on the Map Topology Button 
o Include only the ElevationGuideA feature class in the topology, accept all 

other defaults 
 Use the shared edit tool and the Reshape Selected Topology Edge button on the 

PLTS Editing toolbar to generalize the elevation bands 
 Remove any small tops. 
 Save edits. 

 

Adding Drains to the EGB 
 

 Add/copy streams from WatercrsL / WatercrsA that help describe the elevation 
change on the sheet. Add both perennial and intermittent if necessary, as well as 
canals/ditches if appropriate. 

o Add the WatrcrsL / WatrcrsA feature classes from the production GDB 
o Select a representative pattern to be included in the EGB. 
o Start an Edit session and set the Target layer to either 

ElevationGuideHydroL or ElavtionGuideHydroA depending on what you 
have selected. 

o Perform a Copy/Paste to copy the features in the selected Target Layer 
o Calc the ‘F_CODE’, ‘HYC’, ‘MSNAME’, and ‘PRNAME’ attributes for 

the new features. 
 Generalize stream shapes.  It helps to unsplit the drains using the ‘HYC’ attribute.   

o Click on Select by Attributes (located on the PLTS Editing Environment 
Toolbar) 

o Set the Query to look for HYC = 8 
o Click on the Unsplit, located on the PLTS Advanced Editing Toolbar 
o Choose to unsplit the selected features and click OK. 
o Repeat for HYC = 6 

 Edit turnbacks of elevation zones where needed. 
 Save Edits 
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Adding Spot Heights to the EGB 
 

 Add the ElevP feature class from the production database to your data frame. 
 Select a representative pattern of 10 spot heights - including the highest, the 

lowest, and 8 other spot heights that describe the elevation on the sheet.  The spot 
heights included on the elevation guide must be represented on the basemap. 

 Set the Target Layer to the ElevationGuideElevP feature class. 
 Perform a Copy/Paste to copy the selected features into the target layer 
 Select the ElevP layer, right-click and select Propeties 

o Click on the Labels Tab 
o Check on the option to Label features in this layer 
o For the Label Field, select ZV2 
o Click OK to close the property page 

 Open the Set Selectable Layers dialog 
o Make ElevP unselectable 

 Select each of the 10 spots that were copied into ElevationGuideElevP  
 For each spot update the ZV2 and the MSNAME attribute to the correct value – 

using the labels as a guide. 
 Save edits. 
 Stop Editing 
 Save and close the Elevation Guide MXD. 

 

Adding Spot Height Values to the EGB 
 

 Open the mapsheet.mxd 
 Locate the ElevationGuide Box data frame in the TOC. 
 Select the ElevationGuideElevP, right click and select properties 

o Click on the Labels Tab 
o Check on the option to label features in this layer 
o For the Label Field, select ZV2 
o Click OK to close the property page. 

 Zoom to the Elevation Guide surround element on the page layout. 
 Add graphic elements for the spot elevations.  Use the labels as a guide. 

o Select the New Test tool on the Draw toolbar 
o Click on the location in the map to add the spot elevation text 
o Enter the value of the spot elevation – use the labels as a guide.Preferred 

placement is lower right of the spot.  Place labels avoiding black lines 
where possible 

 High value – 8pt Bold Condensed 
 Other values – 6pt  Condensed 

 When done turn off the labels for the ElevationGuideElevP layer. 
 Save the mapsheet.mxd 
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Changing EGB Gridline Color if necessary 
 

 Select the Elevation Guide data frame. 
 Right-click and select Properties > Grid Tab. 
 Highlight the Grid, and select Properties. 
 Select the Lines Tab and set the Line Symbol to the appropriate color. 
 Click OK once, then a second time to close out all property pages. 

 
Customizing the Boundary Guide 
 
The Boundary Guide is similar to the Elevation Guide in that it is a grouped element with 
a data frame.  That means that there are feature classes that can be edited.  Those feature 
classes, as discussed earlier, are located in the PMC geodatabase, in the BoundaryGuide 
feature dataset.  Primarily, the edits you will be performing are to generalize the 
boundary features represented in this element.  The basic procedures are the same as 
those followed when editing the Elevation Guide.   
 
Editing contents of the Boundary Guide 
 

 After Boundary Guide generation open up a new ArcMap session. 
 Add all Boundary Guide Layers 

o The Layers are located in the PMC geodatabase, under the 
BoundaryGuide Feature Dataset 

 Set up Definition Query to edit the Boundary Guide features for your map sheet 
o Select the BoundaryGuide feature layer 
o Right-Click and select Properties 
o Select the Definition Query Tab 
o Click on the ‘Query Builder…’ button 
o In the Fields list – double click on the ‘MSNAME’ attribute 
o For the operator, select  ‘=’. 
o Either Find the MSNAME in the Unique List on the right of the window 

and double click on it, or enter in the name of the mapsheet surrounded by 
single quotes – i.e., ‘V795X64462’ 

o When the Query is set Click Verify, click OK  
o If the expression passed, Click OK on the Query Window, and OK on the 

Properties window 
o Repeat these steps for the BoundaryGuideHydroA feature layer. 

 Zoom to the visible features. 
 Using the editing tools available, Reshape and Modify, generalize the boundary 

features  
 Save edits. Close and save the mxd 
 Switch to the mapsheet.mxd 
 Zoom the location of the Boundary Guide, and verify that your edits are reflected 

in the element. 
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Grid Systems 
 
The procedures outlined below are specifically for creating a grid system for TLM50 map 
sheets.  This general outline can be followed for any reference system associated with a 
data frame in ArcMap: 

 Create the reference system 
 Convert to the reference system to graphics or features (converting to features is 

only available if PLTS is installed) 
 Edit graphic elements or features as desired 

A data frame can have multiple grid systems displayed at one time.  More complex 
reference systems may require that components of the system are present in two different 
reference systems (tick marks in one system, labels or grid lines in another) to meet 
product specifications.  When converting any grid system to graphics or features it is 
extremely important that the zoom level for the page layout is set to at least 800%.  
Not doing so could introduce inaccuracy into the converted components.   
 

DD Grid Reference System – TLM50s 
 
Verify that the following properties are set for the ‘DD Grid’ system associated with your 
TLM50 map sheet prior to beginning any conversion process. 
  

 Open the property page of the Layers Dataframe 
 Select the Grids Tab 
 Higlight the ‘DD Grid’ and select Properties 
 Select the Intervals Tab  

      Interval
o The X Axis Interval should be 0.0833333333333 
o The Y Axis Interval should also be 0.0833333333333 

       Origin
o Select the option to Define your own origin 
o The X Origin should be -180 
o The Y Origin should be -90 

 
Converting the DD Grid 
  
The most complicated part of working with the grid systems is keeping track of which 
elements have been converted from the data frame grid to either a graphic element or a 
feature class.  When a grid is converted, either to graphics or a feature class, only those 
components of the grid that are visible on the screen will be included in the conversion 
process.  Keeping this in mind you can selectively choose which elements from a grid 
system are converted.  In addition, you can convert one part of a grid system, labels for 
example, to a graphic, and not convert the tic marks. 
 
The only components of the ‘DD Grid’ that will be converted are the labels.  Once they 
are converted you will have control over the placement of the individual labels.   
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 Open the Property Page of the basemap Data Frame, Select the Grids Tab 
 Select the ‘DD Grid’and click on Properties 
 Select the Axes Tab and un-check all of the options for: 

o Top, Right, Left, Bottom placement for the Major Division 
o Top, Right, Left, Bottom placement for the Subdivision 

 Select the Border Symbol Options, and set the color to No Color (this will keep 
the neatline from being converted to a graphic) 

 Select the Lines tab 
 Choose the option to not show lines or tics 
 Click OK to Close the Grid property page. 
 Click OK to Close the Data Frame Property Page 

 
At this point the only component of the ‘DD grid’ system that should be visible are the 5 
minute labels along the edge of the mapsheet. Now you can convert just those elements to 
graphics. 
 

 Zoom to the Lower Left corner of the basemap Data Frame 
 Open the property page of the basemap Data Frame 
 Select the Grids Tab 
 Highlight the ‘DD Grid’ and select Convert To Graphics 
 When the process is completed, ArcMap automatically turns off the visibility of 

the entire ‘DD Grid’ (notice the check box next to the grid) reference system 
 Click Properties - Now you will turn on the items that were not converted, and 

turn off those items that were converted 
 Click on the Axes Tab 
 Check-on the options for 

o Top, Left, Right, Bottom placement for the Major Division 
o Top, Left, Right, Bottom placement for the Subdivision 

 Select the Border Symbol Options, and set the Color to Black 
 Select the Lines Tab 
 Choose the option to Show as grid of tics 

o The symbol should be the DD Crosshair symbol, if not select it using the 
symbol selector 

o The Buffer distance should be 20 pts 
 Select the Labels Tab 
 Uncheck the Label Axes options for the Top, Right, Left, and Bottom 
 Turn on the Visibility of the ‘DD Grid’ 
 Click OK to Close the Grid Property Page 
 Click OK to Close the DataFrame Property Page 

 
All of the components of the ‘DD Grid’ system should now be visible in your mapsheet.  
Remember the labels are now graphics. ArcMap still automatically generates the neatline, 
tic marks, and crosshairs.  When the labels were converted to graphics, they were 
converted into a grouped graphic element.  In order to edit the placement of each label, 
select and ungroup this graphic element. 
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 Select one of the labels, notice the selection box goes around the entire mapsheet 
 Right-Click and select Ungroup 
 Select all of the labels again 
 Right-click and select Ungroup one more time. 

MGRS Reference System – TLM50s 
 
Generating the MGRS is a little different than the process followed for the DD grid 
system as the lines and ladder values are converted to features.  Before you begin, one 
change has to made to the properties of the MGRS Grid System:   
 

 Open the Property Page for the Layers (Basemap) Data Frame 
 Select the DataFrame tab 
 Verify that the Enable clip to shape option is un-checked. 
 Select the Grids Tab 
 Highlight the MGRS Grid and select Properties 
 Select the MGRS Tab 

o Un-check the option to Show grid zone square identification labels 
 Click OK to close the grid Property Page 
 Click OK to close the Data Frame Property Page 

 
Converting the MGRS to Feature Classes 
 
The conversion to feature classes works similar to the conversion to graphics used for the 
DD Grid reference system.  Only those features visible will be converted to features in a 
geodatabase.  The components of the MGRS that we want converted to features are the 
grid ladder values and the grid lines.  These are converted so that they can be edited and 
adjusted to avoid overprinting. 
 

***Before Converting Grid Lines to Feature Classes*** 
To ensure that the Grid lines are converted to feature classes in the most accurate 

position it is extremely important that your page layout zoom level is greater than 800% 
before completing the following steps! 

 
 Open the basemap Data Frame Property Page 
 Select the Grids Tab 
 Highlight the MGRS Grid and click Properties 
 Select the Axes Tab and un-check all of the options for: 

o Top, Right, Left, Bottom placement for the Major Division 
o Top, Right, Left, Bottom placement for the Subdivision 

 Select the Labels tab and un-check the Top, Right, Left and Bottom placement 
options 

 Click OK to Close the Grid Property Page 
 Click OK to close the Data Frame Property Page 
 Zoom to the lower left corner of the basemap to at least 800%.  This will ensure 

that the grid lines are converted accurately. 
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Add the Convert Map to Feature Class tool if it is not already present in ArcMap.  There 
are instructions for doing that in the latest TLM Production procedures located in the 
PLTS Online Help under Map Production System > MPS Enhanced Grid Properties > 
Converting Map Grid to a Feature Class. 
  

 Once the Tool is loaded, go ahead and run it 
o Convert only the MGRS Grid into your carto GDB 

 After the conversion process is completed, open the property page for the 
basemap data frame 

 Select the Grids Tab 
 Select the MGRS Grid and click Properties 
 Click on the MGRS Tab 

o Un-check the option to Show Ladder Values 
 Click on the Labels Tab  

o Check on the options to place labels along the Top, Left, Right, and 
Bottom 

 Click on the Lines tab 
o Select the option to not show as grid or ticks 

 Click OK on the Grid Property Page 
 Click OK on the Data Frame Property Page 

 
Add the MGRS_Grid_Line and MGRS_Grid_Anno feature classes to your basemap data 
frame. You should now have all of the components of the MGRS present on your 
mapsheet.  The lines and annotation can be edited using the same tools as the used when 
editing the other features within the basemap.  There is one extra step that is required to 
get the MGRS to match specifications.  Every 10th grid line (0, 10, 20, 30, 40, etc.) needs 
to be a heavier line weight than the others.   

 
 Start an edit session 
 Select every tenth grid line (lines associated with 10, 20, 30, 40, etc ladder 

values), these are the major grid lines. 
 Calc the ‘SYMBOL_SIZE’ attribute to 10 for each of these lines 
 Save edits made to the grid line attributes 
 Open the Property page for the MGRS_Grid_Lines layer and symbolize the lines 

using the SYMBOL_SIZE attribute. 
 Assign the symbol sizes as follows: 

o Major Grid Lines, mpsblack .25mm 
o Minor Grid Lines, mpsblack  .1mm 

 
The MGRS labels can be converted to graphics to improve the label placement and 
correct overprints.  To do so, follow the same general procedures outlined for the DD 
Grid Reference System.  Keep in mind that only those that are visible on the map sheet 
will be converted to graphics. 
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Secondary Grid Systems – TLM50s 
 
Some maps will require a secondary grid system because of the sheet’s geographic 
location in relationship to UTM Zones.  The TLM50 map series and TLM50 style contain 
two reference systems, the Labels – 2nd Grid, and the Tics – 2nd Grid for generating the 
secondary grid system.  The properties for each of these reference systems will need to be 
updated and edited for each map sheet.  

Adding the Secondary Grids 
 

 Select Tools > Options… from the ArcMap main menu 
 Click on the Application Tab 

o Un-check the option under the Wizard Mode Section 
o Click OK to close the Options Dialog 

 Open the Basemap Data Frame Properties Page 
 Select the Grids Tab 
 Click On ‘New Grid’ 

o Click on ‘More Styles’ 
o If the latest style has been copied to your arcgis\arcexe83\bin\styles then: 

 Make sure the TLM50 style is checked  
o If the latest style has NOT been copied to this location 

 Click ‘Add…’ and navigate to the location of the latest 
TLM50.style 

o Scroll Down through the list and Select the ‘Labels – 2nd Grid’ 
o Click OK 

 In the list of the Grid systems, change the name of the ‘Measured Grid’ to ‘Labels 
– 2nd Grid’ 

o Click once on the existing name to change it 
 With the ‘Labels – 2nd Grid’ highlighted, click ‘Properties’ 

o Select the ‘System’ Tab  
o Choose the Option for another Coordinate System and click on 

‘Properties’ 
o Click on the ‘Select…’ button 
o In the dialog, select the Secondary/Minor grid system – 

ProjectedCoordinateSystem/UTM/WGS84/[ProperUTMZone] 
o Click ‘Add’ then ‘OK’ on the Spatial Reference Window 
o Select the Intervals Tab 
o Verify that the Units are set to ‘Meters’ if not change it. 
o Set the X-Axis and the Y-Axis to 10000 
o For the Origin Section 

 Choose the Define your own Origin option 
 Set the X-Origin and the Y-Origin to 0 

o Click OK to Close the Reference System Property Page 
 Click on ‘New Grid’ 

o Click on ‘More Styles’ 
o Scroll Down through the list and Select the ‘Tics– 2nd Grid’ 
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o Click OK 
 In the list of the Grid systems, change the name of the ‘Measured Grid’ to ‘Tics – 

2nd Grid’ 
o Click once on the existing name to change it 

 With the ‘Tics – 2nd Grid’ highlighted, click ‘Properties’ 
o Select the ‘System’ Tab  
o Choose the Option for another Coordinate System and click on 

‘Properties’ 
o Click on the ‘Select…’ button 
o In the dialog, select the Secondary/Minor grid system – 

ProjectedCoordinateSystem/UTM/WGS84/[ProperUTMZone] 
o Click ‘Add’ then ‘OK’ on the Spatial Reference Window 
o Select the Intervals Tab 
o Verify that the Units are set to ‘Meters’ if not change it. 
o Set the X-Axis and the Y-Axis to 10000 
o For the Origin Section 

 Choose the Define your own Origin option 
 Set the X-Origin and the Y-Origin to 0 

o Click OK to Close the Reference System Property Page 
 

That’s number two set up.  Now you will have to convert the tics marks reference 
system to graphics in order to align the tic marks with the neatline.  This is an 
inherited problem from ArcMap.  These grids are made from the ArcMap Measured 
Grid systems.  Unfortunately, this type of grid system does not honor the clip to shape 
property that we use for TLM production.  The Tic marks align very nicely with the 
data frame, but not the actual edge of our map sheet.  Therefore they have to be 
converted to graphics and adjusted to the edge of the neatline. 
 

***Before Converting Tics – 2nd to Graphics*** 
To ensure that the tick marks are converted graphics in the most accurate position it is 

extremely important that your page layout zoom level is greater than 800% before 
completing the following steps! 

Converting the Ticks – 2nd Reference System 
 

 Zoom to the lower left corner of the basemap to at least 800%.  This will 
ensure that the grid lines are converted accurately. 

 If the Data Frame Property page is not open, go ahead and open it. 
 Select the Grids Tab. 
 Highlight the ‘Tics – 2nd Grid’ Reference System 
 Click on the Convert To Graphics Button 
 Click OK to close the Data Frame Property Page 

 
The ‘Tics –2nd Grid’ is now a grouped graphic element on you map sheet.  To work 
with the individual Tics, select this grouped element, right-click and select Ungroup. 
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The labels should be converted in the same way.  Open the data frame property page, 
and convert the ‘Labels – 2nd Grid’ to graphics and adjust them accordingly. 
 

**** Before Adjusting Tics associated with the 2nd Reference System **** 
It is extremely important that you display the grid lines for the 2nd reference 

system prior to adjusting any of the tic marks! 
 

 Open the Basemap Data Frame Property page. 
 Select the Grids Tab 
 Highlight the ‘Tics – 2nd Grid’ Reference System 
 Click ‘Properties’ 
 Select the ‘Intervals” Tab 

o Change both the X and Y Intervals to 1000 
o Verify that the origin is set to 0, 0 

 Select the ‘Lines’ Tab 
o Choose the option to ‘Show as a grid of lines’ 
o Select a line color that will be easy to see.  These lines do not have to 

match any specifications – they are for your reference only. 
 Select the ‘Labels’ Tab 

o Turn off the labels on all four sides 
 Select the ‘Axis’ Tab 

o Turn off all of the Major Division Tic Marks 
o Turn off all of the Minor Division Tic Marks 

 Click OK to close the Grid Property page 
 Click OK again to close the Data Frame Property Page 

 
Start adjusting the secondary grid tic marks to align with the neatline of the basemap.  
Use the grid lines that you just set up as guides to ensure the accuracy of the tic marks 
as you move the coincident with the neatline.  The grid lines can be turned off when 
completed.  However, they should be turned on again and verified prior to producing 
any output.   

 

Creating Annotation 
 
This section outlines the general steps required for converting labels to annotation feature 
classes.  Prior to beginning any of the conversion check that all of the appropriate fonts 
are loaded on the system.  The steps outlined below assume that a Geoname shapefile or 
feature class is being used to generate the annotation.  See the FAQ section for help with 
generating a Geoname shapefile or feature class. 
 
Annotation characteristics follow MIL-STD 2402 of 21-April, 1995 and MIL-T-89306, 
section 3.19 of 28-February, 1995. 

Create an Annotation Dataset 
 Open Arc Catalog and navigate to the production geodatabase. 
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 Confirm that there is an annotation feature dataset. (If not, you must create one.) 
o Go to File in the Arc Catalog Menu 
o Add new Feature Dataset 
o Name it appropriately  
o Click on the Edit button 
o Click on the Import Button on Coordinate System Tab 
o Navigate to a feature class in the production database. 
o Click OK once then a second time. 

 Close ArcCatalog 

Labeling Features 
 Add the Geoname shapefile/feature class to the mapsheet.mxd. 
 Right click on the Geoname layer and Select properties 
 Click on the Labels Tab 
 Click “Label Features in this Layer” 
 If the data will be labeled the same, do the following: 

 Method: “Label all feature the same way” 
 Proceed to the Text Symbol Button instruction below 

 If your data will be labeled in more than one way, do the following: 
 Method: “Define classes of features and label each class differently”  
 Class: Default, check off “Label Features in this Class” 
 Click Add Class button and give the class a name 
 Click “Label Features in this Class” box for your named Class 
 Click on SQL query: Query for the fields you require (see below) 
 Text String Label Field: Create a label string as you require 

 Click on Text Symbol Button. 
 Select the appropriate color, font, size, & style for text.  Adjustments for various 

feature font sizes can be made later in the data. 
 Click on Label Placement Properties 
 In the Placement Properties, Placement box, click on “Change Location” button 
 Select an appropriate label position and accept all defaults in this window. 
 Click the Conflict Detection Tab, Click “Place Overlapping Labels Button” 
 Accept all other defaults. 
 Click OK. 

Converting Labels to Annotation 
 In the layout view, zoom to full extent of map sheet 
 Right Click in the Data Frame for the Properties 

 Click on Data Frame Tab and change extent to Fixed at 1:50,000. 
 Click on the General Tab and set the Reference Scale to 1:50000. 
 Exit the Data Frame Properties. 
 ENSURE THAT ONLY ONE FEATURE LAYER IS VISBLE AT ALL TIMES 
 Right-click on the feature layer and select Convert Labels to Annotation 
 In the Convert Labels to Annotation dialog, uncheck and un-highlight all labels. 

Check and highlight a single set of labels to be converted.  
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It is Important that only one label class is highlighted and has been checked on 
to convert. Not doing so will cause your labels to be converted to graphics within 

the map sheet.  Do not try to convert the labels to annotation in batch!! 
 

 Create Annotation For:  “Features Displayed in the Current Extent” 
 Check on “Create overlapping labels for all layers” 
 Un-check the option to “Display Overlapping Labels in Overflow Window” 
 Confirm that Reference Scale is 1:50000   

• If it is not, close the Convert Labels to Annotation dialog 
• Open the Data Frame Property Page 
• Select the Data Frame Tab 
• Set the extent to Fixed at a scale of 1:50000 
• Click OK to close the property page 
• Go back up to the step marked with a ‘ ’ and proceed from there. 

 Storage Options: In a Database. 
 Navigate to the Anno50K and click add 
 Name the annotation class you are about to create:  
 Click OK 
 Repeat this process until ALL feature layers are annotated. 
 For the sake of clarity, you may want to add annotation from multiple feature 

layers which have similar themes into one annotation subclass 
 An example of some naming conventions for annotation feature classes and 

associated queries are: 
• Hydrography – hydro_anno – Query: FC = ‘H’ 
• Population – pop_anno – Query: FC = ‘P’ 
• Locality/Area – area_anno – Query: FC = ‘L’ 
• Spot elevations – spot_anno 
• Hypsography – hypso_anno – Query: FC = ‘S’ 
• Transportation – trans_anno – Query: FC = ‘T’ 
• Contours – contour_anno 

 
Feature Destination Codes used in Geonames are available on-line at:  
http://gnpswww.nima.mil/geonames/GNS/index.jsp
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Output 
 
This section will discuss the most common output formats for TLM map sheets.  They 
are printing, color separation, and PDF or EChart format.  The general procedure for each 
of these types is outlined below.  In addition, the Clip-to-Shape property is discussed.  
The Clip to Shape property sets up the proper boundary for the map sheet, and should be 
set prior to producing any output. 
 
There are a few things to keep in mind before producing any output from the map sheet.  
By far the most important is that all polygon layers with stipple fill patterns (Scrub, 
Intermittent/Dry Streams) must be exported to a coverage w/regions prior to any attempt 
of the output procedures.  Undesired results can appear if these layers are not exported 
such as incomplete printouts and ArcMap crashing during color separation.   
 
Once the layers are exported to a coverage with regions, the regions must be added back 
into the basemap.  Because the coverages are not part of the geodatabase and outside the 
control of the VVTs, they will have to be rendered manually. The steps for completing 
this are outlined in the section on plotting.    
 
The next most important item to keep in mind is to visually check the neatline of the map 
sheet before producing output.  The data frame in ArcMap will shift around slightly on 
the page.  This shifting can cause misalignment between the neatline and any graphic 
elements placed coincident with the neatline.  The best way to avoid this is to save your 
map sheet at a zoomed in level – anything greater than 800%. This will greatly minimize 
the shifting of the data frame on the page layout.   
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Setting up the Data Frame with Clip to Shape 
 
The basemaps on TLM map sheets are not rectangular.  They can either be longer on the 
bottom than the top (in the northern hemisphere) or longer on the top than the bottom (in 
the southern hemisphere).  However, data frames in ArcMap – which is what the 
basemap is contained in – can only be a rectangle.   
 

Actual TLM 
Extent 

 
 
 
 
 

Basemap 
Data Frame 
Extent 

 
 
 
 
 
 
In order to resolve this difference in shapes, the clip to shape property is used.  This 
property uses the extent of an entire feature class, or a single polygon, and clips the 
features in the data frame to the selected extent.  All features, and some of the grid 
systems (DD and MGRS are clipped, while measured grid systems like the one used for 
the secondary grid system are not) are clipped at the defined extent.  For TLM production 
the clip to shape is set to use the extent of a single polygon feature that defines the size of 
the basemap.  
 
Setting up the clip to shape property on a map sheet entails two steps. The first step is to 
add the polygon feature to the basemap that represents the extent of the TLM.  This 
polygon feature can either be a shapefile or a feature class.  If this is not available, the 
index provided in the PMC can be used to define the extent of the clip to shape polygon.  
Once this polygon feature is added to the basemap, the clip to shape property needs to be 
enabled.  The clip to shape is a property of the data frame and is accessed through it’s 
property page.   
 
This property should be set prior to producing any output.  The clip to shape 
property only needs to be set once during the production of the map sheet.  
 
Setting up the Clip to Shape Property 
 
As mentioned previously, the polygon feature that represents the extent of the basemap 
must be added as a layer to the basemap.  This polygon feature can be in the format of a 
shapefile or a feature class.  The shapefile or feature class could contain a single feature 
(map sheet extent), or multiple features (multiple map sheet extents).  If the shapefile or 
feature class contains multiple features, then a separate step will be required once the 
information is loaded as a layer into the basemap.  This extra step sets up a definition 
query so that only the feature that represents the current map sheet is visible.  One source 
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for the map sheet extents is the PMC.  In this geodatabase there is the PMC feature 
dataset that contains the TLM50 feature class, which in turn, holds all of the map sheet 
extents for TLM50s.  The steps outlined below will use this feature class as the source for 
the map sheet extents.  If a shapefile or feature class is used that contains a single feature 
representing the extent of the map sheet, then the steps associated with setting up a 
definition query should be ignored.   
 

 Zoom out to the full extent of the map sheet. 
 Add the TLM50 feature class located in the PMC geodatabase, PMC feature 

dataset. 
 Set up the Definition Query so that the only feature visible is the one representing 

the map sheet being edited. 
o Select the TLM50 layer in the TOC 
o Right-click and select Properties 
o Select the  ‘Definition Query’ tab 
o Click on ‘Query Builder’ 
o Build the Query to look for MSNAME = ‘The Name if your mapsheet’ 
o Click OK on the Query window, and OK on the Layer Property page. 

Now the only feature that is visible in the TLM50 layer is the polygon associated 
with the map sheet being edited. 

 In the TOC, select the basemap data frame, right-click and select ‘Properties’ 
 Click on the Data Frame Tab.  The bottom of this property page holds the Clip to 

Shape controls 
 Verify that there is no border symbol for the Clip to Shape. 
 Click on the ‘Specify Shape’ button, this will open another window. 
 In the Data Frame Clipping Window: 

o Set the Layer option to the layer containing the polygon that represents the 
extent of the basemap (in this example it would be TLM50) 

o Set the Features option to Visible.  This will clip the features at the extent 
of the visible feature. 

o Click on the Outline of Features radio button – even though it is already 
set. 

o Click OK to close the Data Frame Clipping window. 
 Check-on the option to Enable the Clip to Shape 
 Click OK to close the data frame property page. 

 

ArcMap Plotting Procedure 
Plotting procedures will vary from printer to printer. Variations in paper size, print 
quality options, and printer engines may be required to successfully plot from other 
plotters.  

Export all Layers with Stipple Patterns 
 Open ArcCatalog and navigate to the location of the production geodatabase. 
 Select the feature class to be exported. 
 Right-Click and select Export > Geodatabase to Coverage 
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 The defaults are usually OK at this point.  Verify the location of the output 
coverage and that the Output Feature Class is set to Region. 

 Once the conversion is complete, open the map sheet mxd. 
 Add the new region classes to your basemap dataframe.   

o Be sure to add the region class and not the polygon class to the TOC. 
 Symbolize the region coverage with the appropriate stipple pattern. 
 In the TOC, make sure all polygon data is below point and line features. 

Printing the Map Sheet 
 Activate ArcPress (ArcMap\Tools\Extensions…) 
 Open the ArcMap Print window (File/Print) 
 Click Setup… 
 Select appropriate printer  
 Change Printer Engine to Windows Printer 
 Verify Page Orientation is set to “Portrait” 
 Uncheck “Scale map elements proportionally…” 
 Uncheck Map Size “Same as Printer” 
 Move Output Image Quality slider to Best 
 OK 
 Click Printer Engine Properties (Windows) 
 Select Paper Quality Tab, click Advanced, and set Page Size to “ANSI E” 
 OK 
 Select Device Options Tab, set Print Quality to “Max Quality” 
 OK 
 Click Setup… 
 Change Printer Engine to ArcPress Printer 
 OK 
 Click Printer Engine Properties (ArcPress) 
 Select General Tab, set Driver to “HP RTL Device Dithered (RGB) 
 Set Resolution to 600 
 OK 
 Cancel the Print window 
 Click Print 

 
 

Color Separation 
 
The required output format of TLMs are 1-bit 1200 dpi color separated TIFFs. As a 
general note regarding color separation, only CMYK output is possible using ArcMap. 
PLTS and MPS enables maps to be exported to the required output of 1-bit TIFF format 
color separate files. In order to produce maps that will color separate to valid TLM 
specifications it is required that only colors predefined in the TLM50.style or 
TLM50_high_res.style are used throughout the map sheet.   The PLTS Renderer will 
assign the appropriate colors and symbols for the all of the feature layers in the TOC.  
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The NIMA TIFF Separator is used to color separate a map sheet.  This exporter can be 
accessed by going to File > Export in the ArcMap main menu.  In the Export window 
select NIMA TIFF Separator as the ‘Save as Type’.  This exporter is only available with 
PLTS.   
 
There are various options that can be set prior to separating the map sheet.  Those options 
can be accessed by click on the ‘Options…’ button on the Exporter dialog.   The options 
dialog for the separator contains choices for the colors to separate, the format and 
resolution of the TIFF files.  For each color listed in the Plate Definition list there are two 
options; 1) include the color in the separation process; 2) will a color overprint colors and 
symbols beneath it in the draw order.  The first option is trigged by checking on or off the 
box next to the name of a specific color. The second option is controlled by the check box 
in the Overprint column of the plate definition window.  If the Overprint option is un-
checked, than that color will act as knockout and remove all of the symbols and colors 
drawn underneath of it in the map sheet.  If the Overprint option is checked on than the 
color will not knockout symbols or colors drawn underneath of it on the map sheet.   
Using the overprinting option allows the cartographer to ‘erase’ anomalies on the map 
sheet by placing a graphic element on the page with the MPSWhite color.  
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File Format 

 
Compression  

 
 
 Available Colors 

 
 
 
 
 
 
 
 
 
 

Add or Remove 
Individual Colors Output Resolution Open or Save color file (.ect) 

Pre-Separation 
 Open the mapsheet.mxd 
 In the table of contents, verify that all of the stipple pattern area feature classes 

have been converted to coverages 
o If not do so now (see procedures for plotting) 

 Remove all styles from style manager except tlm50_high_res 
 Verify that the Clip to Shape option in the map’s data frame properties is enabled 

o Select the basemap data frame 
o Right-click and select Properties 
o Select the Data Frame Tab and verify the Clip to Shape is enabled. 
o If it is not, it must be se prior to color separation 

 Zoom to the full extent of the mapsheet 
 Check-on the option to Enable 
 Click on the Specify Shape 
 Select Outline of Features 
 Select a polygon layer that represents the exact boundary of the 

map sheet – usually PolbndA or the TLM50 polygon feature from 
PMC that represents the map sheet extents  

 Choose the ‘Visible’ features option 
 Close the Data Frame Clipping Window 
 Close the Data Frame Properties Window 

 If the Clip to Shape option is enabled, cancel out of the data frame properties 
dialogue box and do not reapply this function. 

 Zoom to the full extent of the map sheet in the layout view and let the data redraw 
completely. 
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 If there are area feature classes in the map that have been converted to line feature 
classes for the purpose of blocking out sections of a black outline (ruins areas are 
a common example), insure that they are all mpsblack.  

 Starting at one corner of the map, pan around the neatline and align graphics in 
the following manner: 

 Corner cropmarks to corners 
o Verify that the symbol for the cropmarks contains all of the necessary 

MPS colors. 
 North Arrow to neatline and appropriate meridian 
 Road destination arrows to roads and neatline 
 Verify that all white knockout boxes completely cover the features that they are 

knocking out and are not overlapping the neatline 
 When complete, zoom in to a corner at least 800% 

 

Performing the Color Separation 
 

 Remain zoomed in to the same corner as above. 
 From the file pull down, select the Export Map… option 
 From the save file type as pull down, select the NIMA Tiff Separator  
 Choose to place the tiffs in either the 600 or 1200 folder, depending on the 

resolution of the tiffs that are being generated 
 Click on the Options tab and using the Load from file button, navigate to and open 

the milspec.ect file (located in the PLTS Install Location/bin/styles folder) 
 Select the appropriate DPI resolution (600 or 1200) 
 Click OK 
 Name the output appropriately 

o The name that is entered will be appended with the color of the TIFF File  
 Click OK 
 When complete, save and close the mxd while zoomed in to a corner. 

 

Separation QC 
After the separation process has completed a QC of the TIFF files should be preformed.  
ArcMap can be used to accomplish the QC.  The process involves loading the individual 
TIFF files, symbolizing them, and plotting the composited TIFF files.  
 
Once the following steps are completed, save the MXD.  All of the properties for the 
layers and the data frame will be preserved.  For subsequent map sheets, open this MXD 
and change the source for each of the layers to the location of the new map sheet’s color 
separation files.   
 

 Open ArcMap 
 Add each of the TIFF files to the ArcMap session. 
 From the ArcMap main menu select Tools > Style References  

o Select the TLM50 style 
o Click OK 
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 The next series of steps, down to the step with the ‘ ’ should be repeated for 
each of the TIFF files present. 

o Select the MPSBlack TIFF layer 
o Right-click and select Properties 
o Select the Symbology Tab 
o Choose the ‘Unique Values’ option 
o Click on ‘Add All Values’ 

 There should be two options – 1 for areas without data, and 0 for 
areas with data 

o Highlight the symbol value of 1 and select ‘Remove’ 
o Double-click on the symbol for values of ‘0’ 
o Set the color to match the name of the TIFF File, in this case MPSBlack 

 Click OK to close the layer property window. 
 Now that the layers are set up, the data frame needs to be set. 
 Select the data frame in the TOC, right-click and select Properties 
 Select the ‘General’ Tab 

o Change the Map Units to Inches 
o Change the Display Units to Centimeters 
o Set the Reference Scale to 1:1 

 Select the Data Frame Tab 
o Select the Fixed Scale option at a scale of 1:1 

 Click OK to close the Property page 
 Switch to the Layout View 
 Change the page size to something more appropriate – ANSI E 
 Resize the data frame so that the entire map sheet is visible. 
 Ensure that the TIFFs are listed in the TOC in the order listed below, and that 

each file is assigned the appropriate MPS color. 
o MPSBlack  
o MPSRedBrown67-30-60 
o MPSAeroblue  
o MPSBlue  
o MPSRedBrown  
o MPSRedBrown (Knockout) 
o MPSRedBrown54-60 
o MPSBlue31-45 
o MPSBlack7-45 
o MPSBlack54-45 
o MPSBlack31-45 
o MPSBlack42-45 
o MPSBlack21-45 
o MPSBlack12-45 
o MPSGreen  
o MPSGreen31-45 
o MPSRedBrown7-45 

Plotting 
Refer to the ArcMap Plotting Procedure for plotting guidance.  
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E-Chart  Production 
 
NGA’s newest format of TLM50s are E-Charts.  Currently, an E-Chart is simply a PDF 
of a finished mapsheet.  The PDF format allows for quicker dissemination of the final 
product to the customers in the field.  The E-Chart also allows for paperless QC, as the 
PDF files can be marked up with graphic edit calls.  Customers can also quickly query a 
map sheet for any text located on the face of the basemap.  In the future, it is envisioned 
that the E-Chart will be delivered in a geo-referenced format, allowing the customer to 
perform basic spatial queries directly on the digital map sheet.   
 
E-Chart production through ArcGIS is a two-step process.  The first step is to convert the 
completed map sheet to an EPS file.  One the EPS file is created, Adobe Acrobat Distiller 
is used to convert the EPS file to a PDF format.   
 

Generating an E-Chart 
 

 Open the completed mapsheet.mxd. 
 From the ArcMap Main Menu, select File > Export 
 In the Export window, Change File Type to EPS 
 Select an appropriate name and location for the outputted file 
 Open Adobe Acrobat Distiller 
 Select the EPS file and name the PDF file 
 QC the PDF file to ensure all features converted successfully. 
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Troubleshooting - FAQs 
 
How can I edit the Elevation Guide or Boundary Guide contents in one ArcMap 
session, and view the changes in another? 
 
The ability to edit feature classes in one ArcMap session and view those edits within 
another ArcMap session running concurrently is because of feature layers.  Any feature 
layer in the Table of Contents is a pointer to a feature class, not the actual feature class.  
Because they are only pointers, the underlying feature classes can be edited outside of the 
mapsheet.mxd, or any other mxd for that matter.  Edits can be performed on the feature 
classes in the second ArcMap session.  After saving these edits, the mapsheet.mxd is 
refreshed, and the feature layers (pointers), still pointing the same feature class (edited), 
are updated with edits. 
  
I keep getting an error when I attempt to generate the Elevation Guide Element. 
 

 Do you have a DTED present in the Table of Contents? 
 

 Are there any broken layers in the TOC (signified by a ‘!’)? 
o If so, re-source those layers with the broken sources 

 
 Before loading the DTED was the option to ‘Make newly added layers visible’ by 

default disabled?  
o If not, remove the current DTED layer, and refer the steps for generating 

the elevation guide. 
 

 Is the DTED layer checked on as visible in the TOC? 
o If it is, remove the DTED and refer to the steps for generating the 

elevation guide. 
 
If the elevation guide will still not generate, contact PLTS support: 
http://support.esri.com/index.cfm?fa=software.filteredGateway&PID=34
 
 
I keep getting an error when I attempt to generate the Boundary Guide Element. 
 

 Is there a POLBNDA or POLBNDL layer present in the TOC? 
o If not, add one and generate the Boundary Guide. 

 
 Is there a WATRCRSA or WATRCRSL layer present in the TOC? 

o If not, add on and generate the Boundary Guide. 
 

 Are there any broken layers in the TOC (signified by a ‘!’)? 
o If so, re-source the layers with the broken sources 

 
If the Boundary Guide will still not generate, contact PLTS Support. 
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http://support.esri.com/index.cfm?fa=software.filteredGateway&PID=34
 
What if I have saved my map sheet as an MXD but I need to regenerate an MPS 
surround element like the Elevation Guide? 
 
The easiest way to do this is to copy and paste the missing element, in this case the 
Elevation Guide, from the map sheet opened through MPS to the MXD.  To accomplish 
this: 

 Open the map sheet through MPS, using the Create Map Sheet Menu 
 Generate the missing element using the MPS software 
 Place the element in the proper location on the map sheet 
 Save the map sheet 
 Select the element to copy into your MXD. 
 Zoom the page layout to 1:1 (using the Layout toolbar) 
 In a separate ArcMap session, open the map sheet MXD 
 Pan to the location of the missing element in the MXD 
 Zoom the page layout to 1:1 (using the layout toolbar) 
 In the MPS Map Sheet, select Copy 
 In the MXD, select paste. 

 
The element and all of its components will be copied from the MPS map sheet to the 
MXD.  It is very important that both the MPS and MXD map sheets be zoomed to the 1:1 
level – if not the element will be copied with the incorrect size. 
 
 
The data frame keeps shifting around when I open and close my MXD, how do I 
keep it from doing this? 
 
The best way to eliminate the data frame shifting is to save your map sheet MXD at a 
zoomed in location, preferably around one of the corners of the base map.  Zoom into 
location on the page layout to anything greater than 800%, then save the map sheet.  Each 
time you save the map sheet make sure that you are zoomed into at least this level on the 
page layout.   
 
When I convert my labels to annotation they are converted into graphic elements in 
my data frame not features in the annotation feature class I selected? 
 
When converting labels to annotation there are two things that must be completed within 
the Convert Labels to Annotation dialog: 
 

 Make sure that the label class you want to convert is checked-on 
 Make sure that the label class you want to convert is highlighted as well 

 
If either of these steps is not followed, the labels will be converted to graphic elements in 
your data view and not features in your annotation feature class.   
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Labels cannot be converted to annotation in a batch mode.   
 
Why are there two neatlines on my map sheet? 
 
There could be a couple of reasons for multiple neatlines to appear on your map sheet. 
 
The DD Grid system is generating the required neatline for your basemap.  Check to 
make sure that none of the other grid systems have an associated border. Open the 
property page for each of the other grids systems and verifying that the border is turned 
off. 

 Through the data frame property page, open the grid system’s property page. 
 Select the Axes tab 
 Select the Properties button for Border 
 Verify that the color is set to ‘No Color’ 
 Close all property pages 

 
The neatline may have been converted to a graphic element when converting other 
portions of the grid system.  Select the neatline that was converted to graphics and delete 
it using the select elements tool on the Draw toolbar. 
  
This may be a little confusing because of overlapping elements (i.e. Trim Guide, Data 
Frame, Crop Marks, etc.), so make sure that you have actually selected the graphic 
element representing the neatline prior to deleting anything.  To check this: 
 

 Select the second neatline, right click and select properties.   
 If the symbol selector dialog appears with a black outlined polygon symbol then 

you have selected the neatline go ahead and delete it.   
 If not you have either selected the trim guide, or the data frame.  Close the 

property page, and with the element selected, right-click and select Order > Send 
to Back 

 Unselect the element (ESC Key) and select the neatline again. Check the property 
page again to make sure you have the neatline. If so, go ahead and delete it.  

 In some cases there may be more than one graphic neatline, make sure each one is 
deleted so that when you are finished, there is a single neatline that is coincident 
with the features. 

 
I ran the Bridge Renderer to generate my bridge symbology, but now every time I 
try to open the map sheet ArcMap crashes? 
 
This is because the ArcMap is attempting to generate the bridge symbology prior to 
activating the code used to generate the bridge symbology.   

 Open an empty ArcMap session 
 Make sure that the toolbar with the Bridge Renderer is present (PLTS Carto Tools 

toolbar). 
 Select File > Open and select the MXD you are working on an open it 
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I have heard that the Grids in ArcMap are inaccurate, is this true? 
 
No, the grids generated in ArcMap are accurate.  However, when a grid system is 
converted to either graphic elements or features, inaccuracies can be introduced if the 
proper steps are not followed.  The most important of these is to zoom to at least 800% in 
the page layout prior to converting any grid system.  By doing this you will eliminate any 
inaccuracies that could be introduced during the conversion process.   
 
How do I symbolize my road features so that the Streets and Through Route 
features symbolize properly? 
 
To symbolize the Street and Through Route features properly (so the road casings are 
open at intersections), follow these steps: 

 Add three new layers of RoadL 
• A rendered RoadL feature class should exist in the TOC 

 Maintain the RoadL name for the original RoadL 
• Set up a definition query for this layer: TUC <> 6 AND TUC <> 7 

 Rename the first new layer “Through Routes” 
• Set up a definition query for this layer: TUC = 7 
• Set the symbol width to 0.3mm 
• Set symbol color to MPSRedbrown  

 Rename the second new layer “Streets” 
• Set up a definition query for this layer: TUC = 6 
• Set the symbol width to 0.3mm 
• Set the symbol color to MPSWhite 

 Rename the third new layer “Casings” 
• Set up a definition query for this layer: TUC <> 4 
• Symbolize on Unique Value, TUC 
• TUC = 6, symbolize as 0.5mm, MPSBlack 
• TUC = 7, symbolize as 0.5mm, MPSBlack 

 
Once the layers are set up a symbolized properly, they can be saved as layer files and re-
used for on any future map sheets.  Refer to the ArcGIS help on creating and using Layer 
files. 
 
 
I need to rotate some point symbols.  How do I do this? 
 
Symbols associated with point features can be rotated based upon an attribute field.  For 
most TLM products, this rotation field is the ‘AOO’ attribute field.  However, the 
rotation field can be any set to any numeric attribute field on a feature class.  Once this 
attribute is defined as the rotation field, simply updating the field with a new value will 
rotate the point symbol.   
 

PLTS TLM50 Guidance Using MPS 3.1 - September 2004  37   



PLTS TLM50 Guidance Using MPS 3.1   September 2004  

If there is a field present on the point feature class that holds the rotation angle then 
follow these steps to symbolize the features using the stored value 
 

 Right-click on the layer and select Properties 
 Select the Symbology Tab 
 If you have used the PLTS Renderer to symbolize your features, select the PLTS 

Renderer option in the Show list 
o Click on the Rotation Button 
o In the dialog that appears, select the attribute field storing the rotation 

angle 
o Select the appropriate rotation style. 
o OK out of all the property windows 

 If you have not used the PLTS Renderer, select the Features option in the Show 
list 

o Click on the Advanced button 
o Select Rotation 
o In the dialog that appears select the attribute field storing the rotation 

angle 
o Select the appropriate rotation style 
o OK out of all the property windows 

 
Once a rotation field is set for the layer the point symbols will rotate based upon the 
value in this field.  To change the symbol rotation, change the value in the rotation field, 
or use the rotate button located on the PLTS Advanced Editing Toolbar. 

Adding a Rotation Field 
A rotation field is required in order to rotate point features for cartographic purposes. If it 
is not present it needs to be added to those point feature classes that will require rotating. 
The following outlines the steps required to add the missing field to a feature class. Once 
the field has been added, it can be utilized in ArcMap to store the rotation angle for an 
individual feature. 

 Open ArcCatalog 
 Navigate to the feature class that you want to add the rotation field 
 Right click and select Properties 
 Select the Field Tab 

 
In the top half of the property page is a listing of all of the attribute fields for this feature 
class, as well as their type. Using the scroll bar to the right of this list, scroll to the bottom 
of the list. 

 
 In the first empty box under the field name column, enter the name for the 

rotation attribute field 
 In the data type column set the type to ‘Long Integer’ 
 Click OK to close the property page 
 Close ArcCatalog 
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When I symbolize culverts and point bridges only half of the symbol appears.  How 
do I get the complete symbol? 
 
Using the PLTS Renderer for culverts and point bridges will only create half of the 
required symbol.  For bridge or culver a different spacing between symbols may be 
required based upon the symbol for the type of associated transportation feature.  In order 
to generate the other half of the symbol, the point feature must be duplicated and offset, 
and rotated to display the proper symbology.   
 
How do I create a Geoname shapefile or feature class from the tab delimited text 
file? 
 
A geoname file is typically provided in a tab delimited text file, but in order to create 
annotation, the geonames need to be in either a shapefile or feature class format.  To 
convert the geonames file into a shapefile, ArcMap is used.  To generate a feature class 
from the geonames file ArcCatalog is used.  Both methods are outlined below. 
 
Geoname to Shapefile 
  

 Open ArcMap 
 From the ArcMap main menu select Tools > Add XY Data 
 In the Add XY Data window: 

o Select the geonames 
o The X Field should be set to LONG 
o The Y Field should be set to LAT 
o For the Spatial Reference, Select Edit… 
o Click on Import, and select one of the feature datasets from the production 

geodatabase. 
o Click OK to close the Spatial Reference Dialog 
o Click OK to close the Add XY Data dialog. 

 The geoname point features are now added as an Events layer.  In order to convert 
labels to annotation, the Events layer must be converted into a shapefile 

 Right-click the Geoname layer and select Data > Export Data… 
o Select Export All Features 
o Select the option to use the layer’s spatial reference 
o Define a name and location for the shapefile 
o Click OK 

 Click OK to add the exported shapefile as a layer.   
 Remove the Geoname Event’s layer from the TOC 

 
Geoname to Feature Class 
 

 Open ArcCatalog 
 Add the PLTS Toolbar if it is not already available 

o From the ArcMap main menu select Tools > Customize 
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o Select the PLTS toolbar 
o Close the Customize dialog 

 Select the Import Ancillary Sources into GDB command from the PLTS toolbar 
 Select the type of GDB to load the data into 
 Select the appropriate source, in this case Geonames 
 For the Source Input, click on the Browse button, navigate to and select the 

geonames file. 
 Click on Next 
 Choose to create the feature class in a new or existing geodatabase 
 Based upon your choice of GDB, complete the Geodatabase location information.   
 Click on Finish 
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